IT IS ILLEGAL TO MAKE UNAUTHORIZED COPIES OF THIS SOFTWARE

This software is protected under federal copyright law. It is illegal to make or distribute copies of this software except to make a backup copy for archival purposes only. Duplication of this software for any other reason including for sale, loan, rental or gift is a federal crime. Penalties include fines of as much as $50,000 and jail terms of up five years.

SIERRA

as a member of the Software Publishers Association (SPA), supports the industry's effort to fight the illegal copying of personal computer software.

Report copyright violations to:
SPA, 1101 Connecticut Avenue, NW, Suite 901
Washington, DC 20036

LIMITED WARRANTY NOTICE

Sierra On-Line, Inc. wants your continued business. If you fill out the enclosed product registration card and return it to us, you are covered by our warranty. If your software should fail within 90 days of purchase, return it to your dealer or directly to us, and we will replace it free. After 90 days, enclose $5 for 5.25" disks (or $10 for 3.5" disks) and return the software directly to us. Sorry, without the registration card you are not covered by the warranty. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

COPYRIGHT NOTICE

This manual, and the software described in this manual, are copyrighted. All rights are reserved. No part of this manual or the described software may be copied, reproduced, rented, translated or reduced to any electronic medium or machine-readable form without the prior written consent of Sierra On-Line, Inc., P.O. Box 485, Coarsegold, CA 93614.
CONQUESTS OF CAMELOT

KING ARTHUR

THE SEARCH FOR THE GRAIL
CREDITS

EXECUTIVE PRODUCER
Ken Williams

GAME DESIGNER
Christy Marx

ART DESIGNER
Peter Ledger

PRODUCER
Guruka Singh Khalsa

LEAD PROGRAMMER
David Slayback

COMPOSER
Mark Seibert

DOCUMENTATION
Christy Marx
Marti Mc Kenna

DOCUMENTATION ART
Mark DeMent

ANIMATORS
Douglas Herring  Ken Nishiiuye  Andy Hoyos
Jennifer Shontz  Peter Ledger

BACKGROUND ARTISTS
Peter Ledger  Julian Ledger  Douglas Herring

PROGRAMMERS
Bob Fischbach  Jerry Shaw  Eric Hart  Doug Oldfield

DEVELOPMENT SYSTEM BY
Jeff Stephenson  Bob Heitman  Pablo Ghenis  Corey Cole
John Hartin  Dan Foy  John Rettag  Corinna Abdul

SOUND EFFECTS BY
Mark Seibert

CAMELOT COMBAT SYSTEM BY
Douglas Herring

SPECIAL THANKS TO
Ellen Guon
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Conquest of Camelot</td>
<td>3</td>
</tr>
<tr>
<td>King Arthur: History vs. Myth</td>
<td>5</td>
</tr>
<tr>
<td>The Grail and the Sacred Cup</td>
<td>7</td>
</tr>
<tr>
<td>The Message of the Rose</td>
<td>7</td>
</tr>
<tr>
<td>Language of the Flowers</td>
<td>7</td>
</tr>
<tr>
<td>Six Goddesses</td>
<td>9</td>
</tr>
<tr>
<td>Mythology of Aphrodite</td>
<td>10</td>
</tr>
<tr>
<td>Bibliography</td>
<td>11</td>
</tr>
<tr>
<td>How to Read This Manual</td>
<td>12</td>
</tr>
<tr>
<td>All Systems; Read Me Instructions</td>
<td>12</td>
</tr>
<tr>
<td>MS-DOS Installation Instructions</td>
<td>13</td>
</tr>
<tr>
<td>Atari ST Installation Instructions</td>
<td>14</td>
</tr>
<tr>
<td>Amiga Installation Instructions</td>
<td>15</td>
</tr>
<tr>
<td>All Systems; Playing the Game</td>
<td>16</td>
</tr>
<tr>
<td>Need a Hint?</td>
<td>24</td>
</tr>
<tr>
<td>Problem Disk?</td>
<td>25</td>
</tr>
<tr>
<td>Walkthrough</td>
<td>28</td>
</tr>
</tbody>
</table>

Liber Ex Doctrina
INTRODUCTION

The trick with writing a story or game based upon a popular set of legends is to walk that thin line between tradition and originality. What I’ve striven to do with this game is to balance history and myth, fact and imagination, entertainment and information.

Rather than adhere slavishly (and boringly) to specific stories, I drew upon the essence of the Arthurian legends and other mythologies to create a blend which I think will challenge you and entertain you at the same time. You will certainly encounter ideas that you never found associated with a King Arthur story anywhere else.

Before you start, take the time to read through this book. Much of the information is vital to playing the game. You will find tips and hints that will help you get the most enjoyment from your game. I guarantee you’ll discover new and unusual pieces of history, not just in this book, but hidden layer within layer throughout the game.

A word about copy protection: as an experiment, we are not doing any copy protection on these disks. It would be quite difficult to play the game without this book, but there is no foolproof method of preventing someone from pirating a game.

Pirating can vary from the person who deliberately sets out to distribute a game to as many people as possible, to the player who casually loans his disks to “a few friends” to copy.

But consider this: my husband and I have spent a year of our lives working virtually every day of every week to create this game for you. I have done uncountable hours of research, laboring over every detail, to make this the best game I can produce.

Every time someone pirates this game, whether to one person or to hundreds, that is money that we, the creators, will never see. That is money we don’t get to pay rent or buy food or get our cars fixed or, perish the thought, maybe see a movie once in a while.

A pirate who steals this game is not simply depriving a faceless corporation of a few measly bucks. He or she is taking significant earnings away from the creative people who have worked harder than that pirate can imagine for an entire year.

That goes for any game and any software that is sold. It’s no different than stealing a book from a bookstore or stealing a painting from an art gallery. Pirating is not cute or clever or justified. It’s theft, pure and simple. And we, the creative people who pour our hearts and souls into our work, do not appreciate it.

As a purchaser, you can spread this message to those who think it’s okay to pirate, which is the first step in preventing it. And that WILL be appreciated.

Thank you,

Christy Marx
CONQUESTS OF CAMELOT

KING ARTHUR: HISTORY VS. MYTH
Archaeological diggings at a hill known as Cadbury in central southern England have revealed the remains of a fortress dating roughly to the 6th century, based on an even older Roman fortress before that. Cadbury is a location many associate with one of the most famous locations of all time — Camelot.

There are many indications that there was a powerful war leader in that time by the name Arthur, Artur, Artos, Artorius and other variations. A Welsh history from about 850 A.D., the Historia Britonum, provides the earliest written record of him. The 10th century Annales Cambriæ even mentions his date of death as 537 A.D.

He was not known as King Arthur, though at one point he seems to have had the title “emperor.” During his time, the Roman rule of Britain had ended, leaving behind a chaos that would evolve into the Dark Ages. The historical Arthur was noted as probably having a Roman education which he used to create a swift and effective body of cavalry and would have been the last major figure of power before post-Roman Britain sank into its decline. This made his lustre as a warlord shine all the more in the darkness that followed.

Whoever this historical figure may have been, he would be amazed to find himself identified with the Arthurian legends we know today.

The mythological story of King Arthur says that he was the son of Uther Pendragon, King of the Britons. Arthur was conceived and born in Tintagel, then was taken away and raised in secret by the wizard, Merlin. When Arthur reached manhood, he proved he was the true king by drawing a sword from a stone. This sword broke in battle and he received another sword, Caliburn (later renamed Excaliber), from the Lady of the Lake.

He gathered valiant knights around him and built a round table so they would all sit as equals around it. He built the magnificent stronghold of Camelot. He married Gwenhyvier (or Guinevere) and though she loved him, she also loved one of his greatest knights, Sir Launcelot. Launcelot loved her and was forever torn between this love and his loyalty to Arthur.

Arthur fought and won many battles, but was finally mortally wounded by his own nephew-son, Mordred. He was not buried, but was carried away by three Fairy Queens on a boat to the mysterious island of Avalon, where he was to be cured of his wounds and then sleep until the day he was needed again.

This barely scratches the surface of a rich and complex body of myths which have combined and grown over the centuries into the Arthurian Cycle. Very ancient Welsh and Celtic legends link him to the constellation of Ursa Major (The Big Bear) because his name in Welsh,
Arth Vawr, meant Heavenly Bear, meaning that he was a god in his earliest form.

Numerous other gods and goddesses lost their divinity and became his knights, rival kings and various ladies. An early Welsh Goddess, Gwenhwyfar, resurfaced much later as Arthur’s queen, Guinevere.

There are scores of Welsh and Celtic legends about larger-than-life heroes who go upon monumental quests, rescue or win their ladies, and search for miraculous treasures. They faced giants, visited magical islands and fought in the underworld. Most of these colorful tales eventually found their way into the Arthurian Cycle in one form or another.

In the 2nd century A.D., 5,500 Sarmatians who were defeated by the Romans in a battle on the frozen Danube were sent in exile to northwestern England to serve as border guards against the Scottish Picts in the north. These Sarmatians originally came from southern Russia and were roving, marauding mounted warriors complete with chainmail and heavy lances.

More significantly, they brought with them an entire body of tales about a heroic king named Batrados who had a body of loyal knights, a sword in a stone, a miraculous cup, and a magic sword that had to be thrown into an enchanted lake as he lay dying. All of these elements and more seem to have been assimilated into the Arthurian legends.

From the 12th century onward, the legends acquired the themes of chivalry and courtly love (devotion to a particular lady) which arrived along with the Normans who invaded England and brought with them the troubadour influence of France. During this time, Launcelot appeared in the stories and he and Guinevere became significant figures, caught in the tragic love triangle with Arthur. At this late point also the Round Table was added to the stories.

And finally, around the same time, the Arthurian legends were Christianized and, later still, the quest for the Grail was attached and gained dominance. The theme of sin causing the downfall of Camelot and the need for the healing grace of the Grail are now completely associated with King Arthur, yet they are very late additions.

Century after century, storytellers continue to embellish and embroider this fascinating mix of history, mythology and pure fantasy.

THE GRAIL AND THE SACRED CUP
Grail derives from the Medieval Latin word “cratella” meaning “bowl.” One of the Medieval writers of the Arthurian saga, the 12th century French Poet, Chretien de Troyes, left behind after his death an unfinished poem about a knight-hero named Perceval. This poem was taken up and used by later writers until it became
EUROPE AND THE MIDDLE EAST
the story of Parzifal and his encounter with the Holy Grail and the Spear of Longinus (the Roman spear used to pierce Christ in the ribs as he hung on the cross).

In 1485, the most famous of the Arthurian storytellers, Sir Thomas Malory, wrote *Morte d'Arthur* (The Death of Arthur) in which the search for the Grail became a permanent part of the legends affixed to the court of Camelot.

In these various versions, the only knights who ultimately proved pure enough to see or possess the Grail were Parzifal (Percival), Sir Bors and Galahad.

The basic myth says that Joseph of Arimathea was a priest of Jerusalem who supervised the burial of Jesus. He acquired the cup from which Jesus drank at the Last Supper and into it gathered drops of Christ's blood, either while Jesus was on the cross or during his burial. Joseph brought the Grail to Britain where he established a shrine on Glastonbury Tor.

But there is no doubt that the Grail legend itself is firmly based upon the much more ancient myths of the Sacred Cup of the Goddess. In virtually every mythology in every culture, the cup or chalice or cauldron is a symbol of feminine power, the ability to create life and grant fertility.

Just as the Grail was reputed to have the power to heal and to give endless food and drink, so were there endless older myths of a Sacred Cup or cauldron which gave life or other boons.

It appeared in the earliest legends of Egyptian, Babylonian, Indian and Norse mythology where it was linked to a Goddess (or a female trinity as a Triple Goddess) who gave birth to the universe and often there were three cauldrons from which various gods and heroes would drink to gain power or knowledge.

To the Celts, it was the Cauldron of Regeneration in which injured or slain warriors could be resurrected. In other tales, it was a bowl that provided endless food and drink that was wrested from the underworld, or the cauldron of a giant.

To the Welsh, it was one of the Thirteen Treasures of Britain, the enchanted Cauldron of Inspiration that would not cook the meat of a liar or a coward.

To the Sarmatians, it was "Amonga," a magic cup that gave endless food and drink and also would not boil the meat of a coward.

Even the Christian legend of St. John the Evangelist associated him with rebirth from a boiling cauldron until his festival was expunged from Christian calendars in 1960.

That the Grail is really the Sacred Cup of the Goddess is inescapable, even in the name of Joseph of Arimathea. The literal translation of "Arimathea" means "belonging to the Goddess-mother Mari."
THE LANGUAGE OF THE FLOWERS
From the earliest days of civilization, flowers have been given special meanings. For example, the rose has a long association with love, sexuality and with many goddesses, the Virgin Mary, and the science of alchemy.

Not only the flower itself, but often the color indicated what significance was attached to it. There are many legends of flowers springing up where drops of blood or tears fell to the ground. What follows is a list of flowers and their meanings:

<table>
<thead>
<tr>
<th>Flower</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Almond blossom</td>
<td>hope</td>
</tr>
<tr>
<td>Anemone</td>
<td>withered hopes</td>
</tr>
<tr>
<td>Aster</td>
<td>afterthought</td>
</tr>
<tr>
<td>Buttercup</td>
<td>memories of childhood</td>
</tr>
<tr>
<td>Carnation</td>
<td>heartbreak</td>
</tr>
<tr>
<td>Columbine</td>
<td>folly</td>
</tr>
<tr>
<td>Chrysanthemum, yellow</td>
<td>slighted love</td>
</tr>
<tr>
<td>Chrysanthemum, white</td>
<td>truth</td>
</tr>
<tr>
<td>Cornflower</td>
<td>celibacy</td>
</tr>
<tr>
<td>Daffodil</td>
<td>death</td>
</tr>
<tr>
<td>Forget-me-not</td>
<td>true love</td>
</tr>
<tr>
<td>Hyacinth</td>
<td>sport, game or play</td>
</tr>
<tr>
<td>Lily, white</td>
<td>purity</td>
</tr>
<tr>
<td>Lily, yellow</td>
<td>falsehood</td>
</tr>
<tr>
<td>Orchid</td>
<td>seduction</td>
</tr>
<tr>
<td>Periwinkle, blue</td>
<td>early friendship</td>
</tr>
<tr>
<td>Periwinkle, white</td>
<td>pleasures of memory</td>
</tr>
<tr>
<td>Poppy, red</td>
<td>consolation</td>
</tr>
<tr>
<td>Poppy, scarlet</td>
<td>fantastic extravagance</td>
</tr>
<tr>
<td>Snowdrop</td>
<td>hope or consolation</td>
</tr>
<tr>
<td>Sunflower</td>
<td>haughtiness</td>
</tr>
<tr>
<td>Tulip, red</td>
<td>declaration of love</td>
</tr>
<tr>
<td>Tulip, yellow</td>
<td>hopeless love</td>
</tr>
<tr>
<td>Violet</td>
<td>lust</td>
</tr>
</tbody>
</table>
MIRACULOUS BUSH OF FLOWERS
SIX GODDESSES

ASTARTE
Astarte was the Goddess of Byblos, from which our word for "bible" originated. She was known as the Star, the Moon, the Heavenly Virgin, Queen of the Stars and the Queen of Heaven. Some of her other names were Tanit, Ishtar ("the star"), Astroarche ("Queen of the Stars") and Attar-Samayin ("Morning Star of Heaven"). The Israelites burned incense, offered wine and baked cakes in her honor. Her great shrines were at Byblos and Aphaea (known today as Afka). King Solomon built a sanctuary to her in Jerusalem. Her priestesses were famous astrologers.

ATHENE
She is best known as the Greek Goddess sacred to the city of Athens. Originally, she was a Libyan goddess imported from North Africa. In the Greek legends she was born from the head of Zeus. She has dozens of attributes which include: warrior-goddess and protectress of heroes; patron of architects, sculptors, spinners and weavers; protectress of horses and oxen; and a counsellor-goddess famed for her wisdom. The owl is associated with her. Sulphur is an element identified with her because it was believed that burning brimstone (sulphur) would drive away the evil spirits that caused disease. Athene's major temple was the Parthenon which means "virgin-house."

CERES
Ceres was a Roman goddess with the title “Mother of the Harvest.” Her Greek name was Kore, the virgin aspect of Demeter. She ruled over all grains and the words “cereal, kernel, core, corn” comes from her name. Her major early-summer festival was called the Cerealia celebrated on April 19th. Farmers performed rituals to her to safeguard their crops. One of her other titles was “Ceres the lawgiver” and her priestesses were important in founding the Roman legal system. Her sacred “matronae” ("women of rank") ruled Rome from 600-200 B.C.

ISIS
She was the major Great Goddess of Egypt, known also as Hathor. She was considered the mother of every other god created in the primeval time. Two of her titles were “Giver of Life” and “The One Who Is All.” She gave birth to the sun. The Pharaohs believed she would grant them immortality by resurrecting them after death as she did her husband Osiris. Some Egyptians believed that the yearly flood of the Nile was caused by her teardrop. She was enormously popular with the Romans who called her “the eternal savior of the race of men.” Her son was Horus, the Egyptian Divine Child. The word “pastor” comes from “Pastophori” meaning “servants of Isis.”

VENUS
She was the Roman version of Aphrodite. Her sign represents the female gender in both plants and animals. She is associated with love and sexuality. Mirrors are
objects considered sacred to her. The morning and evening "star" (in reality, a planet) was named after her. Her sacred day was Friday on which her followers would eat fish. Julius Caesar built a marble and gold temple in her honor. In alchemy, her symbol stands for copper. Her main shrine was on Cyprus which was a center for mining copper. She was once also a Lady of Animals and the word "venison" means literally "Venus' son."

**VESTA**
She was the Roman version of the Greek goddess, Hestia. She was considered the "guardian of the innermost things" — home and hearth. Her name comes from "vas," a Sanscrit word meaning approximately "shining." She personified earth, and domestic and religious fire. The perpetual sacred fire of her temples was tended by six women known as the Vestal Virgins. Young girls who entered this order took strict vows of chastity for thirty years, after which they could marry. The fire of her hearth/altar was considered to be the center of the earth.

**THE MYTHOLOGY OF APHRODITE**

**APHRODITE**
She is a fundamental Goddess known by scores of names with dozens of attributes. Aphrodite is simply the name by which she came to be known via the Greeks, but she was an ancient deity even then. She was variously considered the goddess of life, ideal or chaste love, sexuality, marriage, childbirth, fate, death, arts, crafts, culture, hunting and the sea. She was truly a queen among goddesses.

From 70 A.D., her cult dominated the main temple of Jerusalem. There is a legend that in the 4th century the Empress Helena, mother of Constantine, found the true cross (on which Christ was crucified) hidden in a crypt beneath the temple of Aphrodite in Jerusalem.

The sacred number of Aphrodite is six. Symbols associated with her and representing fertility are the dove and the apple.

**APHRODITE AND ADONIS**
Adonis was a youth of such extraordinary beauty that he was adored by Aphrodite. When he was but a child, she hid him inside a chest which she left in the care of Persephone, goddess of the underworld. But Persephone disobeyed Aphrodite and opened the chest. Seeing Adonis, she too fell in love with him. When Aphrodite came to fetch the young man, Persephone refused to release him.

The warring goddesses ended their dispute when Zeus decreed that Adonis would spend half of the year with Aphrodite and half of the year in the underworld with Persephone.

But Ares, the god of War, was jealous of Aphrodite and her passion for Adonis. He transformed himself into a boar, waited for the young man to go hunting, and fatally gored him, leaving Aphrodite to bitterly mourn her lost love.
APHRODITE AND PYGMALION
Pygmalion was a sculptor who lived on the island of Cyprus. Aphrodite was displeased with the women of his town, who had refused to accept that she was divine. She cursed them so that they lost all sense of modesty and would give themselves to any man who came along.

Because of their behavior, Pygmalion disdained the company of women, but nonetheless he devoutly worshipped Aphrodite. He remained alone, carving his statues. One such statue, carved of ivory, was of a woman so beautiful that he fell deeply in love with her image. But she was only a statue until Aphrodite heard his prayers and pleas. Pygmalion was rewarded for his devotion. The cold ivory turned to warm flesh as his statue came to life and embraced him.

APHRODITE AND HIPPOLYTUS
Hippolytus was the son of King Theseus. He was an avid hunter who rode out every day in his chariot. Aphrodite loved him because of his handsome form, but he scorned her love and the love of all women. Furious at being rejected by the handsome prince, Aphrodite caused his stepmother, Phaedra, to fall in love with him, but Hippolytus rejected her as well. Phaedra convinced Theseus that his son had raped her whereupon the King called upon the sea-god, Poseidon, to exact vengeance. While Hippolytus drove his chariot along the shore of the Saronic Gulf, Poseidon sent a fierce bull from the waves to panic the horses. They stampeded and Hippolytus was dragged to his death behind the chariot.

BIBLIOGRAPHY
This is a partial list of books used as research and reference:
- Celtic Myth & Legend, Poetry & Romance, Charles Squire
- Folklore, Myths and Legends of Britain, Readers Digest Assoc. Ltd.
- Funk & Wagnalls New Encyclopedia
- The Golden Bough, Sir James George Frazer
- King Arthur and His Knights, Sir James Knowles
- Larousse Encyclopedia of Mythology
- The Sacred Mushroom and the Cross, John M. Allegro
- Warriors of Arthur, John Matthews & Bob Stewart
- The Woman's Encyclopedia of Myths and Secrets, Barbara G. Walker
- The Woman's Dictionary of Symbols and Sacred Objects, Barbara G. Walker

I highly recommend, as a meticulously researched and brilliantly conceived account of Arthur and Merlin, the superb trilogy by Dame Mary Stewart: The Crystal Cave, The Hollow Hills, and The Last Enchantment. Thank you, M.S., for lifelong inspiration.

Thanks also to Joel Anderson, Antique Coin Dealer, for his help with the coinage of the ancient world.

I would like to receive your feedback and comments on the game. Please write to Christy Marx c/o Sierra On-Line, P.O.Box 485, Coarsegold, CA 93614
HOW TO READ THIS MANUAL

Throughout this manual we will use the following ways of representing information:

- **MENU COMMANDS** will be CAPITALIZED.
- Example: SAVE, RESTORE, QUIT, PAUSE GAME
- **Typed commands** will appear as **bold type**.
  - Example: ‘type: [example game command]’ 'type: cd \sierra'
- Portions of the command line not meant to be typed will **not** appear in **bold type**. For example, in the line ‘type: cd \sierra’, ‘type:’ should not be typed.

[EXAMPLE TEXT] and [Keystrokes] will appear in brackets setting them off from the surrounding text.

- Example: [NAME OF GAME] [NAME OF DIRECTORY] [Spacebar], [Tab], [PageUp]

The brackets are not keystrokes and should not be typed.
- Two or more keys that should be pressed at the same time will be separated by a hyphen (-). This hyphen is not a keystroke, and should not be typed.
  - Example: ‘Press [Ctrl-I] to view your inventory.’
  - If a space appears between parts of a command, it is meant to be typed.
  - Example: ‘type: cd \sierra’ (the space between cd and \sierra should be typed as part of the command)
  - The term ‘diskette’ is used to refer to either 3.5” or 5.25” data storage disks.

ALL SYSTEMS

PLEASE NOTE: There is a README file on your game diskette. It may contain important information and instructions that were not available at the time the documentation and other materials for this game were printed. Failure to review the README file before installing the program may cause unexpected results during installation, loading or playing the game.

**MS-DOS README INSTRUCTIONS**

From DOS, type readme to see the README file onscreen. Use [PageUp]/[PageDown] keys to scroll through the file.

**ATARI ST README INSTRUCTIONS**

To view the README file from the desktop, double-click on the README.DOC icon. You will see a message box with choices for SHOW, PRINT, and CANCEL. Choose SHOW to view the file onscreen one page at a time. Press [ENTER] to see the next screen. Choose PRINT to print the file. Choose CANCEL to escape the message box.

**AMIGA README INSTRUCTIONS**

Insert WorkBench disk into drive DF0: and turn on your system. Double click on the CLI icon.

- **Users with one drive:** Copy the TYPE command into your RAM disk. See your Amiga owner’s manual for instructions. Insert Disk 1. Type: **type readme**.
- **Users with more than one drive:** Insert WorkBench in drive DF0:. Insert Disk 1 in drive DF1:. Type: cd df1:. Type: **type readme**.
GETTING STARTED: DISKETTE DRIVES
It is always advisable to make back-up copies of your
master program diskettes to increase the life of the masters
and guard against accidents. Follow your computer's
instructions to make copies of all game diskettes.

Even if you will be playing from a hard disk, you may
want to format a blank diskette for saving games. In fact,
saving games to diskettes is a good idea, even if you are
playing the game from your hard disk. Follow your
computer's instructions to format a blank diskette and
keep it handy for saving your game as you play. For some
helpful tips on saving games, see the 'Saving Your Game'
(Page 14) section of this manual.

When installing your program, you may be prompted to
insert a 'Drivers' disk. If you receive this prompt, please
examine your disks and insert the disk marked 'Drivers'
and press [ENTER], so that the appropriate drivers will be
loaded. Some games do not include a separate 'Drivers'
disk.

MS-DOS

INSTALL THE GAME
Place the back-up copy you have made of Disk 1 into your
diskette drive. Type the letter of the disk drive you have
placed the disk into followed by a colon (for example: a:),
and press [ENTER]. Type: install and press [ENTER].

Answer the onscreen questions using the up and down
[Arrow] keys to highlight your selections, then press
[ENTER] to select. You will be asked if you wish to install
the game on your hard disk. If you do not wish the game to
be installed on your hard disk, press [ESC] to skip this
step. If you want to install the game on your hard disk,
enter the letter designation of your hard disk (usually C)
and follow the prompts.

PLEASE NOTE: Even if you install to a hard disk, the
install procedure will write a file named
RESOURCE.CFG to Disk 1. For the installation to be
completed correctly, DISK 1 MUST NOT BE WRITE
PROTECTED. No other files on Disk 1 are written or
changed by the install command.

LOADING INSTRUCTIONS
After completing the INSTALL procedure:

From diskettes:
1. Place Disk 1 into the A: drive.
2. Type: a: and press [ENTER].
3. Type: sierra and press [ENTER].

From hard disk:
1. From your root directory, type cd \sierra and press
[ENTER].
2. Type [SPECIFIC COMMAND] and press [ENTER].
SAVING GAMES TO DISKETTES

PLEASE NOTE: If you’re playing from diskettes, you must have a separate formatted diskette ready before you can save a game. We also recommend that you create several directories on your save game disk in order to assure adequate space for save game storage.

Choose SAVE GAME from the File menu or press the [F5] key. The Save Game menu will appear.

Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to clear the command line.

Type the letter of the drive you are using for saved games, followed by a colon (Example: a:) and press [ENTER].

Type the name of your saved game and press [ENTER] to complete the SAVE GAME procedure. If your disk for saving games is full, you may reformat it (this will erase the saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK

If you choose to save games to the hard disk, the program will automatically try to save to the game’s own directory. If you run out of space for saving games, try one of the following alternatives:

Save additional games to diskette.

Save games to a different directory by choosing CHANGE DIRECTORY from the SAVE GAME menu (inside the game).

Delete all saved games and the saved game directory from your hard disk by following DOS instructions (outside the game). The program will create a new index file within the game directory.

ATARI ST

LOADING INSTRUCTIONS

Note: If you are using an Atari 520 ST without memory expansion, turn off all desk accessories (rename .ACC extension .ACX) before running your Sierra game.

1. If you are playing the game from diskettes: Place Disk 1 in drive A, and open the disk by double-clicking on its icon. Start the game by double-clicking on SIERRA.PRG.

2. If you are playing the game from a hard disk: Open the disk by double-clicking on its icon, then open the game folder by double-clicking on the game folder icon. Start the game by double-clicking on SIERRA.PRG.

HARD DISK INSTALLATION

Please note: More than 512K of memory is needed in order to run Sierra games on your ST If you have a hard disk.

1. Open the hard disk by double-clicking on its icon.

2. Create a game folder by choosing NEW FOLDER... from the File menu. Open the new folder by double-clicking on its icon.

3. Place Disk 1 in drive A.

4. Copy the game disk into the new game folder by dragging the drive A icon into the window you opened in Step 3.

5. Repeat steps 3 and 4 for each of the other game disks.

6. Put the master disks away in a safe place.
CHOOSE A MUSIC DEVICE (Optional)
Your Sierra game is initially set up to play music and sounds through the Atari ST's internal speaker. If you have one of the supported MIDI synthesizers, you may run the MUSIC program to have the game play music through the synthesizer.

1. Open the game disk/folder by double-clicking on its icon.
2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.
3. Select MUSIC DEVICE from the Options menu.
4. Select your synthesizer (or 'Atari ST Internal Sound') by clicking on the appropriate button. Then click on OK.
5. Select INSTALL GAME from the File menu. This will replace the RESOURCE.CFG file on your disk.

Please note: It is important to turn your synthesizer on before starting the game.

AMIGA

INSTALLING THE GAME

NOTE: RENAME your copies of all game disks to remove the words 'COPY OF' from the disk name. If the words 'COPY OF' are not removed from the disk names of ALL the copies, the system will continue to ask for the original disk, and will not run the game.

1. Boot your system with WorkBench, and insert Disk 1 of your Sierra game.

2. Double-click on the disk icon, then double-click on the INSTALL icon.
3. Follow the onscreen prompts, choosing your selection with the mouse by clicking once on the item.
4. You will be asked if you wish to install the game on your hard disk. If you do not wish the game to be installed on your hard disk, select NO. If you want to install the game on your hard disk, select YES.
5. Using your mouse, select the drive on which you wish to install the game.
6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS
From Diskettes:
1. If you have less than 1 megabyte of memory for your Amiga, turn your system off and disconnect any external drives.
2. Insert Disk 1 into drive DF0:
3. Turn on your system.
From Hard Disk:
1. Load WorkBench and double-click on your hard disk icon.
2. Double-click on the SIERRA GAMES drawer.
3. Double-click on the drawer for the desired Sierra game.
4. Double-click on the game icon.
ALL SYSTEMS

MOVING YOUR CHARACTER
You may move your character on the screen with the [Arrow] keys, the numeric keypad, the joystick, or the mouse. To halt your character's steps with the keypad, press the number 5, or press the last used direction key again. Do not attempt to move the character by holding down the direction key. This will cause the character to start and stop continuously, resulting in very slow progress.

Using the mouse, position the arrow where you want the character to move, then click the left mouse button (if your mouse has multiple buttons).

MENUS
When you press [ESC], a menu bar will appear at the top of your screen with several menus that can be opened to show the command choices available to you.

KEYS TO USE IN THE MENUS
Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys to highlight items within a menu.

Press [ENTER] to select a highlighted command.
Press [ESC] to return to the game without choosing a command.

GAME SPEED CONTROL
At times it may be useful to slow down the speed of the game animation in order to negotiate a tricky section, or observe something more carefully. At other times, you may wish to speed up the game actions. To increase or decrease animation speed, choose FASTER or SLOWER from the Speed Menu, or use the [+] key to increase speed, the [-] key to decrease speed, or the [=] key to return to normal animation speed.
SHORT CUTS FOR COMMON COMMANDS
You can use function and control keys to short cut many common commands.

[F1] Help
[F2] Toggle sound on/off
[F3], [SPACEBAR] Repeat previous command
[F5] Save Game
[F7] Restore (saved) Game
[F8] Draw/Sheath Excaliber (Toggle FIGHTING mode)
[F9] Restart Game (from beginning)
[SPACEBAR] (in fighting mode only) Swing Excaliber
[Shift] (in fighting mode only) Parry
[Tab] Inventory
[Ctrl-I] Inventory
[Ctrl-O] Open Purse
[Ctrl-P] Pause Game
[Ctrl-Q] Quit Game
[+] Increase Animation Speed
[-] Decrease Animation Speed
[=] Normal Animation Speed
[Ctrl-V] Change Volume
[Shift-Click] ‘Look’ at an object (see below)

SHIFT CLICK
SHIFT-CLICK is a feature that will allow you to ‘look’ at a person or object using your mouse. Place the mouse arrow on the desired person or object, then hold down the [Shift] key and press the mouse button. You will now receive a descriptive message.

PLEASE NOTE: Multi-button mouse users should use the RIGHT mouse button and need not press [Shift].

USING YOUR TAB KEY
While playing Sierra games, your [Tab] key will perform two major functions. You will use it to review the items in your inventory, and also (if you’re not using a mouse) to select options from certain menus. The following menus will require the use of the [Tab] key for highlighting menu options:

MENU

CHOOSE FROM

Restart Game Restart, Continue
Quit Game Quit, Continue
Save Game Save, Cancel, Change Directory, Replace
Restore Game Restore, Cancel, Change Directory
[Death Message Box] Restore, Restart, Quit

USING THE MOUSE (optional)
Your mouse will be useful to you in moving your character, and in learning about your surroundings. To move your character using the mouse, position the arrow to where you want the character to move, then click the left mouse button. In many scenes, you can find out about a person or object by using the [Shift-Click] feature described in ‘Short Cuts For Common Commands’. Also, when a message box appears on your screen prompting,
you to press a function key (such as [F6]), you may point and click on the message box to produce the same results.

RETYPING COMMANDS
If you wish to repeat a command select RETYPE from the ACTION menu or press the [SPACEBAR] or [F3].

INVENTORY
If you wish to see the items you are carrying, select INVENTORY from the Action menu, press [Ctrl-I], or press the [Tab] key. A list of the items you are carrying will be displayed. To look more closely at an item, use your [Arrow] keys to highlight the item and press [ENTER]. A picture of the item, along with a brief description, will appear on your screen. Press [ENTER] or [ESC] to resume play.

PAUSING YOUR GAME
If you wish to pause the game, select PAUSE from the Action menu, or press [Ctrl-P]. Press [ESC] or [ENTER] to resume play.

SAVING YOUR GAME
If you wish to save your game, select SAVE from the File menu, or press [F5]. To allow for errors in judgement and creative exploration, we recommend that you frequently save your game in progress, and that you save several different games from different points as you play. You will always want to save your game before encountering potentially dangerous situations. You should also save your game after you have made significant progress.

Please note: If you're playing from diskettes, you must have a separate formatted diskette ready before you can save a game. Since each disk can only hold a limited number of games, we recommend that you have more than one disk formatted, in order to assure adequate space for save game storage.

If you choose to save games to your hard disk, we suggest that you create one or more save game directories or folders on your hard disk. See your computer's instructions for creating directories or folders.

You may name your saved games using standard English phrases. For example, if you are standing on a sandy beach, you might call your game 'standing on sandy beach', or simply 'beach'.

RESTORING YOUR GAME
Select RESTORE from the File menu, or press [F7]. You will be prompted to select the game you wish to restore. (On a single drive system, you will be prompted to insert your save game disk). Highlight the desired game and select RESTORE. If the game you wish to restore is in a different directory, select CHANGE DIRECTORY.

QUITTING YOUR GAME
To stop playing, select QUIT from the File menu, or press [Ctrl-Q].

RESTARTING YOUR GAME
If you wish to restart your game at any time during play, select RESTART from the file menu, or press the [F9] key. The game will begin again.
TIPS FOR PLAYING CONQUESTS OF CAMELOT
In this game it is important to look for visual clues and to gather information. Anyone you meet might have vital clues. Don’t hesitate to ask characters about other characters or objects when you talk to them. Keep pen and paper handy and be prepared to make notes along with your maps.

Communicating With Conquests Of Camelot
Conquests of Camelot understands many common verbs. Here are some you might try:

<table>
<thead>
<tr>
<th>Ask</th>
<th>Hire</th>
<th>Search</th>
<th>Mount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buy</td>
<td>Eat</td>
<td>Cut</td>
<td>Sit</td>
</tr>
<tr>
<td>Throw</td>
<td>Climb</td>
<td>Get</td>
<td>Push</td>
</tr>
<tr>
<td>Break</td>
<td>Use</td>
<td>Close</td>
<td>Give</td>
</tr>
<tr>
<td>Read</td>
<td>Stand</td>
<td>Dismount</td>
<td>Drink</td>
</tr>
<tr>
<td>Open</td>
<td>Call</td>
<td>Take</td>
<td>Draw</td>
</tr>
<tr>
<td>Look</td>
<td>Trade</td>
<td>Find</td>
<td>Help</td>
</tr>
<tr>
<td>Kneel</td>
<td>Move</td>
<td>Pay</td>
<td>Pray</td>
</tr>
<tr>
<td>Knock</td>
<td>Kill</td>
<td>Sell</td>
<td>Talk</td>
</tr>
<tr>
<td>Smell</td>
<td>Stand</td>
<td>Wear</td>
<td>Kiss</td>
</tr>
</tbody>
</table>

You can generally interact with the game by typing simple commands consisting of as little as a noun and a verb. For instance, the command sit in the chair can be shortened to sit in chair, or even sit. Unless otherwise directed, follow all typed commands with [ENTER].

Many characters in the game will have information of one kind or another for you. To talk with a character, type: talk to [character] (for example: talk to man).

You may encounter objects you need along the way. To take an object, type: take or get [object]. For example, take the note. You will need to use the objects you acquire as you explore. You can try different things such as typing: use the [object], or give the [object] to [character]. Different approaches to a puzzle may bring about a different outcome.

Pay close attention to details. To examine objects, type look at the [object], (for example: look at the table), or press [Ctrl-L], then type the name of the object.

To get a general description of the current room or scene, type look around, or use your mouse to choose LOOK from the menu.

A message window will appear after you enter each command, and at other times during the game. When you have read the message, press [ENTER] to remove the window and resume play.

USING YOUR MAP
When you leave Camelot, you will use a map to travel to other locations important to your quest. Use your cursor keys or click with your mouse to select a location and read the message that accompanies it. A polite message will inform you if travelling to the location you have chosen will not benefit you. If this is the case, press [ENTER] or click again with mouse to remove the message and choose another location on the map. When you have chosen an area that will be helpful to your cause, press [ENTER] to travel to the desired location. You won’t be able to move to another location while a message is on the screen.
LOOK everywhere. Thoroughly explore your surroundings. Open chests and drawers. Look closely at all objects you encounter for valuable objects and clues.

EXPLORE each area of the game very carefully. Search every area of the game. Be careful!! There are many hazards awaiting you!

DRAW A MAP as you progress through the game. Make a note of each area you visit, and include information about objects found there and dangerous areas nearby. If you miss an area, you may miss an important clue!

GET objects you think you will need. You will come across a number of objects that may be of use to you later. You can see an inventory of items on hand by pressing the [Tab] key at any time.

USE the items you have picked up to solve problems in the game, or to help you to make progress and discover more clues.

BE CAREFUL, and remain alert at all times — disaster may strike in the most unlikely of places.

USING EXCALIBER
When battle is imminent, you can use the [F8] key to draw Excalibur. Remember that once you have drawn your sword you are committed to battle. Your only options at this point are to fight, press the [F8] key to sheathe Excalibur, or restore to a previously saved game.

Note: When in Fighting Mode, typed input will not be accepted until you hit the [F8] to sheathe Excalibur.

USING A SPEAR
If you should find yourself armed with a spear instead of your sword, hit the [SPACEBAR] to use your spear at the right moment.

TO JOUST
Your lance is controlled by your numeric keypad, and your shield by the S, E, F, & D keys. See the illustration below for jousting instructions.

SHIELD
S=LEFT, E=UP,
F=RIGHT,
D=DOWN

LANCE
2=DOWN, 4=LEFT,
5=CENTER, 6=RIGHT,
8=UP
FIGHTING MODE
In Fighting Mode (Excalibur is drawn), you will use the [Spacebar] to swing your sword. The [Shift] key should be used to parry or block with your shield. Use your [Arrow] keys or your mouse to move Arthur. These rules apply generally throughout the game with the exception of using a spear, jousting, and the Saracen Battle.

SARACEN BATTLE
In your battle to the death with the Saracen, you face an opponent who is well-armed, skilled and cunning. Hitting keys at random will only wear you down more quickly. Fight as though this were a real battle. Observe what patterns your foe uses and learn to anticipate him. Defending yourself with your shield is as important as striking with your sword. Think, observe, and use strategy.

HOW TO FIGHT
Your sword attacks and your shield parries (blocks the Saracen’s attack). You use all 9 keys on your numeric keypad and the letter “r” on your letter keyboard. See COMBAT GRAPHIC for diagrams.

Note: Once this battle has begun, you are committed to battle and your only option is to fight to the death. [F8] (to sheathe the sword) will not work during this battle, nor will your cursor keys. You must remain in Fighting Mode until you have won or lost.

ATTACKS AND PARRIES
You have a total of 5 ATTACKS and 3 PARRIES available. The HIGH ATTACK or PARRY is for the head and neck area. The MIDDLE ATTACK or PARRY is for the middle body. The LOW ATTACK or PARRY is for the groin and thigh area. You can also take one step backwards (RETRIEVE).

GREAT BLOWS
You also have a GREAT BLOW HIGH and a GREAT BLOW LOW. These 2 attacks are more powerful than a
regular HIGH or LOW ATTACK, but they also take more of your strength and will wear you down more quickly. 

WARNING! It takes longer to prepare and land a GREAT BLOW and will leave you open to a quick attack from your foe. Use a GREAT BLOW with extreme caution and be on guard for a GREAT BLOW from the Saracen against you. Once you have begun a GREAT BLOW you cannot stop it.

POSITION
Do not get backed into a corner. If your stamina seems low and the Saracen is close to giving you no place to retreat, press "r" on the keyboard to swing around him and reverse positions.

STAMINA
Your stamina is how long your strength can carry you through battle. Your stamina level at the beginning of the battle can vary from high to low. Your actions here and in earlier parts of the game will determine your stamina level when you begin to fight and during the fight.

When you fight, each attack you make and each blow landed upon you will reduce your stamina. Using a GREAT BLOW ATTACK will draw most heavily of all upon your strength. Using lots and lots of attacks without strategy will drain your strength quickly. Reversing position lowers your stamina a little each time.

WOUNDS
Both you and the Saracen are wearing armor, so even though it looks like some of your blows have hit or that you have been hit, some have been turned aside by the
armor and done no damage. These are "glancing blows" and do not count as injury.

When you are hit and have taken an injury, you will see a flash on that part of your body. If you land a blow and injure the Saracen, you will see a flash on the part of his body that you have hit. The flash tells you that an injury has been done. This also means that this is where you or your enemy now has a weakness. You must protect your wounded areas while trying to strike again at your foe's wounded areas.

**SARACEN COMBAT GRAPHIC**
The illustrations show the two directions from which you can fight during the battle, and how the ATTACKS, PARRIES and RETREAT work on your numeric keypad. As you can see, the PARRIES do not change when you switch from left to right or right to left, but your ATTACKS, GREAT BLOWS and RETREAT keys reverse position when you change direction.
SAVE YOUR GAME OFTEN, especially when you are about to try something new or potentially dangerous. This way, if the worst should happen, you won't have to start all over again from the beginning. Save games at different points of the game, so you will be able to return to a desired point in the game. In effect, this will enable you to travel backward through time and do things differently if you wish.

DON'T GET DISCOURAGED. If you come to an obstacle that seems insurmountable, don't despair. Spend some time exploring another area, and come back later. Every problem in the game has at least one solution, and some have more than one. Sometimes solving a problem one way will make it harder to solve the next, and sometimes it will make it easier. If you get stuck, you might try backtracking to an earlier point in the game, then choosing a different path. If all else fails, you can buy the Conquest of Camelot hint book from the dealer who sold you the game, or you can order it directly from Sierra On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP: You may find it helpful (and fun) to play the game with a friend. Two (or more) heads are better than one at interpreting clues and solving problems.

NEED A HINT?
If you find yourself 'a little stuck' while playing a Sierra game, try the following ideas:

1. If you have a modem, you can talk to the Sierra Bulletin Board through the following number:

   (209) 683-4463

   Our settings are 300, 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop will be happy to help you.

2. Many other bulletin boards also provide hints to many of our games.
   A. CompuServe: Go into the Gamers Forum (GO GAMERS) or write E-Mail to 76004,2143.
   B. Prodigy: Write E-Mail to 'HTWS90E', or go to the PC Club and enter the adventure games forum (Jumpword: PC CLUB).
   C. PCLink: Select PCLink Plus, enter Publisher's Connection, select Publishers Forums, then Sierra On-Line. E-Mail may be written to the User ID 'SierraOnLi'.
   D. America's On-Line: Select the KEYWORD option from the 'Goto' menu, and type: Sierra. E-Mail may also be written to the User ID 'Serras'.
   E. GEnie: From the main menu select 10 (Games), then select 1 (Games Round Table). Select 1 (Games Bulletin Board), and type set 22 at the '?' prompt. This will take you into the Sierra On-Line area.

   For more information on these BBS lines, you can call these toll-free numbers:
   1. CompuServe (800) 848-8199
   2. Prodigy (800) 822-6922
   3. PCLink (800) 458-8532
4. America's On-Line (800) 227-6364
5. GEnie (800) 638-9636
3. The magazine Questbuster's Journal is a helpful source of many game hints.
4. Your local software dealer may carry our hint books, or may be willing to order them for you.
5. If you are unable to obtain a hint book through a dealer, you can order one directly from us. Call (800) 326-6654 to place your order with a Visa, MasterCard or American Express card, or write Sierra On-Line Inc., Order Department, P.O. Box 485, Coarsegold, CA 93614.
6. If the hint book is not yet available for the game you are playing, call our automated hint line at (900) 370-KLUE to receive a hint.

NOTE: California residents, please dial (900) 370-5113.
Canada, please dial (900) 250-KLUE.

PROBLEM DISK?
TECHNICAL HELP (MS DOS ONLY)
If you are having problems with a game disk, try these suggestions before assuming the disk is faulty:
1. 'Insert Disk (#)': when you have already inserted that diskette, or have installed the game on your hard disk
2. 'Out of Handles' or 'Out of Heap', or if the game locks up at any point
3. 'Disk Error'
you may have memory resident programs loaded into your RAM memory. You will need to boot your system from a diskette containing your operating system only. Follow these instructions to create a 'Sierra Boot Disk'.
Format a blank disk with DOS system files (using /s) to make a bootable disk.

FORMATTING FROM A HARD DRIVE
A) Place a blank disk in drive a:
B) At the C prompt, type: format a:/s

NOTE: If your A: drive is a high density drive and you are using double density disks, you will need to type: format a:/4/s (for 5.25" disks)
or type: format a:/n.9/s (for 3.5" disks)

FORMATTING FROM A DISKETTE DRIVE
A) Place your original DOS disk in drive A.
B) At the A prompt, type: format a:/s (be sure to switch to a blank disk when prompted by the FORMAT program.)
NOTE: If your A: drive is a high density drive and you are using double density disks, you will need to type: format a:/4/s (for 5.25" disks)

or type: format a:/n:9/s (for 3.5" disks)

C) Press [ENTER]

D) Respond to DOS prompts.

Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a files=20 statement. Follow these instructions to create this file:

A) Type: a: [ENTER]

B) Type: copy con config.sys [ENTER]

C) Type: files=20 [ENTER]

D) Press [F6] [ENTER]

You should see the message: ‘1 File(s) copied’. You will now have to re-boot your computer with your new Sierra Boot Disk in the drive. Turn your computer off then on, or press [Ctrl-Alt-Del].

If this does not clear the above messages, call (209) 683-8989 for technical help. Our technical staff will be happy to help you.

TECHNICAL HELP (ALL SYSTEMS)

Technical assistance is only a telephone call away. Call (209) 683-8989 for convenient, person-to-person service, or if you prefer, you may request assistance by mail. If you choose to write to us with your request, please state your computer type and the nature of your problem.

If you find that you need to send for replacement diskettes, send the original disk 1 in the size you need (3.5" or 5.25") to: Sierra On-Line

P.O. Box 485

Coarsegold, CA 93614

Attention: RETURNS

Be sure to include a note stating your computer type, and the size of diskette you need (5.25" or 3.5").

We will gladly replace your program free of charge for the first 90 days of ownership (please enclose a copy of your dated sales receipt with your request). After 90 days there is a $5.00 charge for 5.25" diskettes, and a $10.00 charge for 3.5" diskettes.
WARNING!
THE FOLLOWING SECTION INCLUDES HINTS THAT EXPERIENCED GAME PLAYERS MAY NOT WANT TO SEE.
CONTINUE READING ONLY IF YOU HAVE TROUBLE GETTING STARTED PLAYING YOUR GAME.
WALK-THROUGH
Sit patiently through the introduction to the game at least once and pay attention to clues in both text and pictures.

As the game begins, you are on a floor plan of Camelot. Use your cursor keys or mouse to explore and discover which rooms may be entered. You will use this map to enter a room or to travel from one room to another.

A message window will appear after you enter each command. When you have read the message, press [ENTER] to remove the window and resume play.

Find Merlin’s Room. Press [ENTER] once to remove the message and [ENTER] again to go there, or click once on that room with your mouse.

Type look at the room
Type look at the objects
Type look at the wizard
Type ask about Gawaine
Type ask about Galahad
Type ask about Launcelot
Type where is the Queen?
Type talk to Merlin
Leave Merlin’s Room and find the Queen’s Bower. Press [ENTER] to go there.

Type look at the bower
Type talk to the Queen
Press F3 a few times to continue talking to Queen until she seems to have nothing more to say.

Walk over to Gwenhyver.

Type kiss Gwenhyver
Go ahead, kiss her a few more times.
Type ask about Launcelot
Type look at the rose
Walk over to the rose.
Type pick the rose
Type ask about the message of the rose
Press the [TAB] key to view your inventory. You’ll see that you now have the rose in your possession.
Press the [TAB] or [ESC] key to exit the inventory.
Type look at the rose (when in the inventory)
Press the [TAB] or [ESC] key to stop looking at the rose.
You’ll get a better look at the rose now that you have it.
Leave the Queen’s Bower and try Merlin’s Room again.

Type ask about the Grail
Type look at the map.
Go over to the map in the back, lefthand corner of Merlin’s room.

Type read the map
A close-up of the map will appear. While in Merlin’s Room, this map will give you information. When you leave Camelot, you will use this map to travel to other locations. Use your cursor keys or click with your mouse to select a location and read the message that comes up for it. Use [ENTER] or click again with mouse to remove the message. You won’t be able to research another location while a message is on the screen. Look for clues within the messages. You might even want to make notes. Press F6 to Exit.
Walk over to Merlin’s desk on the right side of the room.
Type look at the desk
Type look at the scroll
Type translate the scroll
Type take the scroll
Walk over to Merlin’s alchemy table on the left side of the room.
Type take the beaker
Being the cautious type, you decide to save your game here. (See ‘Saving your Game’ for instructions.)
Type take the flask
Don’t panic. Merlin will listen to any reasonable apology. If you really get stuck, you can restore to the game you saved just before getting into trouble.
Once you get out of this mess, continue to explore Camelot and don’t hesitate to question anyone you meet. Remember, you are a King with a desperate mission.
Godspeed!

LIBER EX DOCTRINA